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Welcome 
 
Welcome to Booking.com, one of the world‟s leading online hotel reservations agencies. We look forward 
to working with you. 
 
This Starter Kit and FAQ is intended to provide you with information about our company, our hotel texts, 
and our methods of translations as well as the specifics of working with us as a freelance translator. 
Please read it carefully and be sure to let us know if you have any questions. 
 

Please do not start translating until you have read this Starter Kit and FAQ, and confirmed to 
freelancing@booking.com that you have done so. 

 

Freelance Translating for Booking.com 
Probation period 
 
Before we start sending you regular work, we would like to give you the opportunity to understand the 
style of Booking.com. This “probation period” is primarily intended for you to become familiar with the 
content and terminology used in our hotel descriptions, and for the language team to assess your 
translations as well as your ability to consider and implement recommendations. 
 
After each assignment you will receive tips and suggestions about how to write in the style that we 
require. These suggestions must be implemented into your next assignment. If we feel you implement 
our style and translate accurately, you will pass your probation period. You will be paid for all translations 
during your probation period. 
 
After your successful registration with the Google Translator Toolkit (GTT), your first assignment of 
approximately 3.000 words will be uploaded to your GTT account. You will have 3 business days to 
complete the assignment. These projects will appear with an ID number, expiry date, and the number of 
words in your GTT. Please note that all times are CET on a 24:00 hours format. Your deadline is the one 
that we give you in your email. This is different to the expiry date. 
 
In the meantime, you should also have received a link to our eLearning course; if not, you will receive it 
very shortly. However, all the information you need is already included in this Starter Kit. The eLearning 
modules were specifically developed to help you better understand the best way to work with the Google 
Translation Toolkit (GTT). If you have not yet done so, please complete all the modules. Your language 
style guide is also available in the eLearning tool. 
 

When replying to our emails, please do not change the subject line of the email. Always use your 
language code when initiating an email to us. 

 
Once you have completed your first assignment we will perform a quality assessment (QA) on your 
translations. It is important that you read the assessment carefully and acknowledge this by replying both 
to freelancing@booking.com and your language team (as soon as possible, but within 24 hours).  
 
Once you have acknowledged that you have read the assessment, we will upload the second 
assignment. It is important that you implement the suggestions of our language specialist into your 
second assignment. Once you have completed your second assignment and have informed us, we will 
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perform a second quality assessment. We will specifically note if you have implemented the suggestions 
given by our specialists in your first quality assessment. 
 
Once you have acknowledged the receipt of your second assessment to freelancing@booking.com we 
will upload a third, and final probation assignment. Once again when you are finished with this 
assignment, let us know and we will assess your work. We will then determine whether you have passed 
or failed the probation period. 
 

The second and third batches of your probation assignments will only be sent to you after you 
have acknowledged the receipt of the previous quality check to freelancing@booking.com. 

 

Automatic Upload 
 
If you pass the probation period, and if demand allows, your projects will be distributed on an automatic 
upload basis, which means that projects will be uploaded automatically to your GTT account whenever 
you mark one as complete. Our system connects once or twice an hour to your GTT account and it will 
upload new projects until you have between 2 and 3 projects pending completion. When you have less 
than 2 projects, it will upload a new one. Completed projects are downloaded back with the same system: 
once or twice an hour, all projects marked as complete will be retrieved. 
 
Your minimum requirement remains 10.000 translated words per week (Monday-Sunday). Quality checks 
will be carried out frequently and regular feedback will be provided for you. 
 

The word count for any projects marked “complete” after 23:00 CET on Sunday evening will be 
credited for the following week‟s word count. 

 
Please note that it is not possible to average out your word count. For example, you cannot translate 
8.000 words one week, and then translate the remaining 2.000 plus the normal 10.000 in the following 
week. You are obligated to deliver a minimum of 10.000 words per week. 
 
If you run out of translation projects and no new tasks are being uploaded to your toolkit, please contact 
freelancing@booking.com. This email address is available Monday-Friday 09:00h to 17:00h (CET). 
Please only do this after waiting 30 minutes for an upload after marking all your projects complete. 
 

Time Management 
 
Apart from quality, we value reliability. At Booking.com, we understand that you cannot work 52 weeks a 
year and therefore cannot provide 10.000 words every single week. You may need to take a break from 
working with us in order to go on holiday, work for other clients, or be otherwise engaged. It is crucial that 
you inform us as early as possible about your time off, with at least one weeks‟ notice. We need to plan 
our resources, ensure that our hotel texts continue to be translated, and ensure that no projects expire 
unnecessarily. 
 
When you are away for a period, we will switch off your automatic upload so that no projects are 
uploaded and expire unnecessarily during your absence. Once we switch off the automatic upload, no 
new projects will be uploaded into your account after marking the current ones complete. You will also 
have 3 projects in your account at the point we switch off your automatic upload, which we expect you to 
complete before taking your leave so that they do not expire. Please always do this. We cannot reallocate 
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projects. Even though the automatic upload is turned off, the completed projects will still be downloaded 
to our system but no new projects will be uploaded to your account. We will ask you for a date that we 
can switch off your automatic upload. 
 
For example, if you want to take week 10 off you will need to ensure that you translate the minimum of 
10.000 words in week 9. We do not work on the weekend, and we cannot switch off your automatic 
upload outside of office hours. We can also not set the system to automatically switch off your automatic 
upload. 
 
When you return and are ready to work, please send us an email. 
 
If you do not inform us in advance that you are going to take a break, 10.000 words per week (Monday-
Sunday) remains your obligatory minimum. 
 

Project Validity 
 

Do not work on expired projects. Once a project has expired, we can no longer download it back 
to our system and we cannot use the translations. Therefore, in accordance with the terms of the 
agreement, no payment will be due for expired projects. We also *cannot* change the expiry 
date. Always remember to mark your projects complete. Marking them complete after the expiry 
date even if you translated them, does not help. 
 
Never „un-share‟ projects with any Booking.com email address as this will cause technical 
problems for our system when downloading your completed projects. 

 
To avoid confusion with your active projects, please hide any expired projects. This will remove the 
project in question from your active folder. Do not delete projects. 
 

Flagging Brochures 
 
Although our editors are extremely well trained and very experienced, they are also human and can make 
rare mistakes when composing the content of our hotel brochures. 
 
If you notice any major grammatical or orthographical mistakes in the English source text or if you cannot 
understand (parts of) a text for whatever reason, or if you recognise blatant factual errors, please send an 
email to your language team:  translations.xx@booking.com. The xx is your language code which you will 
see from the first emails from the freelancing team. Your language team will be able to help you further 
with how, and which errors to flag in the GTT. 
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Quality assessments 
 
Your translations will be regularly checked for quality and you will receive regular assessments with 
feedback. The aim of this feedback is for you to adapt your translations to the style of Booking.com. 
 

Be sure to read our feedback carefully and integrate it into your next translations. This will 
ensure continuous improvement of your translations and adherence to the translation style 
of Booking.com. 

 
We will assess your translations in a number of ways. We will look at the following categories: 

1. Readability of Target Language 
2. Functional and Textual Adequacy 
3. Translation Accuracy 
4. Specialised Content and Terminology 

You will be given either an a/b/c or d rating for each category and will receive a corresponding score 
between 0 – 3, with a related explanation. The total possible score to be achieved is 12. The checker will 
also write some remarks and comments to further help you adapt your translations to the style of 
Booking.com. 
 
If you have questions about the quality assessment process, please contact your language specialists. 
 

Google Translator Toolkit (GTT) 
Accessing the GTT 
 
The GTT can be found by accessing this link: http://translate.google.com/toolkit. When you access this 
tool, the basic view will show your active projects, the ID number and the word count. This will be empty 
until we have uploaded projects for you. 
 

When you start translating, do keep track of your own word counts. You should note the project 
ID as well as the corresponding word counts. This will help verify your word count at the end of 
the month in case of discrepancies. For exact word counts according to the sliding scale, please 
open each project and go to View >Statistics. 
 
In the GTT, always remember to mark your translations as „Complete‟. Translations not marked as 
complete cannot be downloaded. Translations marked as „Complete‟ after the expiry date can also 
not be downloaded. 
 
To mark as „Complete‟: click Edit > Translation Complete. Please do not use the UPLOAD or 
DOWNLOAD options yourself as we steer these functions centrally 
 
Once marked as complete, projects are downloaded back to our system almost immediately; 
further changes to the brochures cannot be taken into account. 

 
 
 

http://translate.google.com/toolkit


 
 
 
 

Booking.com  
Freelancing Starter Kit and FAQ 

 

 
 

6 
 

Freelancing at Booking.com: freelancing@booking.com -Version 03.2012 

Using the GTT 
 
To start translating a project, simply click on it. The translation interface will open in a new tab or window 
with the source language on the left and your target language on the right. The first segment will be active 
and you can write your translation into the right side and then proceed from segment to segment. 
If you choose to use the various colours in the GTT to clearly see the differences between 100% 
matches, high fuzzy matches and machine translations, then please colour them in the following way: 

 Green for 100 % TM match 

 Orange for “High fuzzy” TM matches 

 Red for Machine Translations 

 Blue for Edited translations (the translations that you have edited yourself) 

 Mustard for ICE matches. ICE (In Context Exact) matches are paid at the same rate as 
Translation Memories – 30%). 

Translation Memory & Glossary 
 

Please be sure that you are using the correct Translation Memory and glossary before you start 
working. 
 
To do so, click on Edit > Properties and you should see the relevant Booking TM and the 
corresponding glossary for your language.  
 
Also: Please be sure to click on „Show Toolkit‟ in order to display translation suggestions from 
our Translation Memory and our glossary or those based on Computer Translation. If the word is 
in our glossary it will be shown with a block around it. 
 
If the Booking.com options for Translations Memory and/or glossary are not available to you in 
the GTT, please inform freelancing@booking.com immediately. 

 

Machine Translations (MT) 
 
Machine translations are translations generated by a machine. Machine translation matches are paid at 
100% of your word rate. 
 

Translation Memory (Full 100%) Matches 
 
The Translation Memory contains previously translated segments and will help you translate more 
consistently and efficiently. If a segment has previously been fully translated, the 100% translation match 
will automatically show up in the target language. In the toolkit, at the bottom of the page, there may even 
be additional options with a 100% match. 100% matches are paid at 30% of your word rate 
 

Please select the best 100% match possible and verify that the translation is satisfactory to you. 
You are responsible for the quality of your translations. 
 
A 100% match always needs to be verified for accuracy! 

 

mailto:freelancing@booking.com


 
 
 
 

Booking.com  
Freelancing Starter Kit and FAQ 

 

 
 

7 
 

Freelancing at Booking.com: freelancing@booking.com -Version 03.2012 

Fuzzy (partial) matches 
 
If a segment has been partially translated before, the fuzzy translation match will automatically show up in 
the target language. In the toolkit, at the bottom of the page, there may even be additional options with 
fuzzy matches. Fuzzy matches are paid at 60% of your word rate. 
 

Please select the best partial match possible and change it so that it is an accurate translation 
that is satisfactory to you. A partial match always needs to be verified for accuracy! 

 

In Context Exact (ICE) and repeat matches 
 
These matches relate to the context of the surrounding text and are generated by Google. Please always 
check them for accuracy before accepting them. ICE matches are paid at the same rate as TM matches – 
30%. Repeat matches are either paid at 60% or 100% of your word rate. 
Unfortunately, Google Statistics don‟t allow you to see the difference. However, our internal tool can 
distinguish the difference in the matches. We suggest you calculate a 60% word rate however; it is 
possible that we might sometimes pay you at 100% of your word rate for these matches. 
 

Translation completion % 
 
The completion % in the translation list is updated asynchronously; it may not immediately reflect the 
latest changes you made in a translation. 
 

When you have finished translating and reviewing a project, you need to mark the translation as 
complete. Otherwise, it will not be downloaded back to us and might expire. 
 
Your translation will be shown as 100% complete when you click on „Edit‟ > „Translation complete‟ 
in the GTT. Even if it shows 100% complete, do not forget to mark your translation complete. 

 

Glossary 
 
The Booking.com glossary for your language will become visible once you activate „Show Toolkit‟ in the 
GTT. This glossary was created by Booking.com with the specific purpose of communicating our 
translation standards. It contains terminology we regularly use on our website, so be sure to adhere to its 
suggestions in order to ensure consistency and clarity/comprehensibility for our customers. However, 
always use your best judgment as terms can appear in different contexts. 
 

Style Guides 
 
Together with this Starter Kit and FAQ you will find a style guide prepared for your language. Please 
make sure that your translations comply with this style guide. 
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Self-Billing & Payment 
 
Booking.com operates with a self-billing system. This means that you do not have to send us an invoice. 
A pre-invoicing calculation will be sent to you at the beginning of every month for the translations provided 
in the month prior. If you notice any discrepancy, please inform freelancing@booking.com within 5 
business days. If the word counts are correct, you do not need to do anything and you do not need 
to email us. Your payment will be made within 30 days of receiving the pre-invoice and is usually in your 
account by the end of the month. Our Finance department will send you a payment advice once they 
have processed the payment. From the day you receive this document, please allow at least one week 
before the money is credited to your bank account. 
 
The credit invoice will be sent to you before the end of each month and it will detail: 
- The number of words you have translated during the last calendar month 
- Their division into MT (Machine Translation), fuzzy (high fuzzy + repeats) and TM (Translation Memory 
+ repeats) 
- The amount owed to you based on this word count and the word rate for your language 
- The amount of VAT to be applied (applicable only for freelance translators registered in the Netherlands) 
 

Payment Rates 
 
- New translation - MT = 100% of rate 
- High fuzzy = 60% of rate 
- 100% match from TM = 30% of rate 
- ICE matches = 30% of rate 
- Repeat = 60% of rate 
 

Bank Information 
 
Our recruitment team asked you for your bank information. If you need to update these details, please 
send an email to freelancing@booking.com with the following information: 
- Your account information in international format (IBAN + BIC/SWIFT, or account number + BIC/SWIFT if 
your country does not use IBAN) 
- The name of the account holder 
- The name of your bank 
- The information for an intermittent account (if applicable) 
- Your local tax ID 
- Your European VAT number (if residing in the EU) 
 

Please note that if your invoice amount is less than € 100, your payment will only be made in the 
month when this amount is reached and/or exceeded. Payments may be delayed in case of 
erroneous or incomplete account information. 
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Frequently Asked Questions (FAQ) 
 

Communication 
 
Q: Do you offer support for freelancers by telephone, Skype or chat? 
A: Not yet. We do however, offer support via email. Please drop us an email at 

freelancing@booking.com and we will get back to you as quickly as possible. 
 
Q: What time zone do you work in? 
A: We‟re in Amsterdam, so CET. 
 
Q: When you say “end of the day” what do you mean? 
A: We mean 17:00 CET. 
 
Q: I would like to take a holiday/break/study leave. When do I inform you? 
A: Please inform us as soon as you know your dates. Not the day before, and certainly not after the 

fact! We request that you give us at least one weeks‟ notice in order for us to plan our resources 
accordingly. 

 
Q:  What happens if I cannot translate 10.000 words per week for a limited period, e.g. due to 

illness or a holiday? 
A: Please let us know as soon as you realise that you are unable to work. We will make a note, and 

you can start translating again when you are able, providing there is enough demand for your 
language. 

 
Q: What do I do when I‟m back from my break? 
A: Please send us an email when you are back. 
 
Q: May I translate more than the minimum of 10.000 words per week? 
A: Yes you may. Just make sure that quantity does not affect quality. If we notice this is happening 

we will stop sending you assignments. 
 
Q: I was ill and unable to translate my minimum word count last week. Is that okay? 
A: We are sorry to hear you were ill but please send us an email as soon as you realise that you are 

unable to translate. 
 
Q: May I directly contact the checker/proofreader to discuss things or ask questions? 
A: Please direct all language related questions to the language specialist that sent your assessment, 

and cc freelancing@booking.com. 
 
Q: There is a mistake in the source text. What do I do? 
A: Please email your language team:  translations.xx@booking.com, where xx is your language 

code. 
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Payment 

Q: Will I get paid for my translations during my probation period? 
A: Of course! We will pay you for your translations during your probation period, whether you 

continue working with us or not. 
 
Q: When will I get paid? 
A: As stated in your Agreement, your payment should be in your account 30 days after the pre-

invoicing calculation is sent. Please only send an e-mail to freelancing@booking.com if you do 
not have your payment by the end of the month. 

 
Q: Will I get paid for projects that have expired while still being translated? 
A: No. Unfortunately our system cannot download projects once they have expired. We cannot use 

the text from expired projects, and we cannot compensate you for those translations. 
 
Q: Do I have to send you an invoice? 
A: No, we take care of the invoicing for you. All you have to do is let us know whether the pre-

invoicing calculation we draw up for you is correct or not. Your payment will automatically go out. 

Quality 

Q: What if I disagree with something in my quality assessment or in the glossary? 
A: You may email us with comments or questions. The purpose of our quality assessments is to 

provide feedback in order to improve your translations in the style we use at Booking.com. If you 
see an obvious mistake in your feedback, feel free to inform your language team. However, 
please remember that Booking.com has its own style. This might differ compared to other 
translations you have worked on before. 

 
Q: In my quality assessment I found an error that was included in an Exact Match from the 

Translation Memory. How is that possible? 
A: You always need to check exact matches. The TM includes everything that was ever translated 

into the GTT by freelancers and in-house translators. Another translator might have made a 
mistake when earlier translating the same sentence. This segment has then been saved in the 
TM and will then be given as an exact match. You must always read through Exact Matches; 
whatever appears under your name is considered to be your work. 

 
Q: Should I exactly follow the translations provided in the glossary? 
A: Yes. The glossaries have been carefully compiled to help you understand exactly what it is that 

we want. However, in some rare cases, deviations from the glossary and the Style Guide can be 
justified. Use your best judgment. When in doubt, always stick to the guidelines and resources 
provided. 

 
Q: In some English brochures, the guidelines provided in the file “Style Guide” are not 

followed. Should I apply them anyway? 
A: Please translate the text as you see it written in the English brochure. 
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Q: What do I do once I have finished a project? 
A: Once you have thoroughly proofread your own work and are happy with the translation, please 

click Edit>Translation complete. It is only once this has happened that you will receive a new 
project in your GTT account. 

 
Q: In some cases the Translation Memory provides more than one segment with an Exact 

Match. How can I select the most appropriate one? 
A: The Translation Memory includes all versions previously translated by other translators. You are 

not obliged to use them, but they can make your work easier and faster. Remember to read the 
segments very carefully and avoid those containing mistakes. Whatever appears under your 
name is considered to be your work. 

 
Q: I noticed quite a few hotel name inconsistencies in the source text; should I stick to these 

as written in the source text or change them to the hotel name used in the caption above 
the brochure? 

A:  Please stick to the different versions of the hotel name you find in the source text. Our editors 
might use different variations of the hotel name for commercial reasons. If there is an obvious 
spelling mistake in the hotel‟s name, use the one in the caption. 

 
Q: How important are the results of the quality checks - what are they used for? 
A: Quality assessments are very important. They reflect the quality of your work. Always ensure you 

read them carefully and implement our suggestions in your next translations. We use the 
quality checks to decide which freelancers we want to continue working with when there is a 
demand decrease in your language. If your quality is not up to the standards of Booking.com, and 
you don‟t follow the guidelines and suggestions from our language specialists, we will have to end 
our Agreement. 

 

Translation & Technology 
 
Q: Can you send me the projects in a separate Word document? 
A: No, all projects must be translated directly in the GTT. 
Q: I notice that the projects are also shared with “translation-bot” and sometimes with a 

Booking.com employee. Can I unshare them? 
A: No. Never, ever unshare your projects with any Booking.com email address. This can cause 

technical problems when downloading your projects back to our system. 
 
Q: What is this translation-bot? 
A: It is a technical account we use to share our projects with you. It has nothing to do with machine 

translation. 
 
Q: Which web browser do you recommend for working in the (GTT)? 
A: We recommend you use Google Chrome. We find this is the most stable browser. You can also 

use Mozilla Firefox, but we recommend Google Chrome. 
 
Q: What if the GTT is not working properly? Do I still get paid for the projects I have 

translated? 
A: As long as these segments are saved properly and downloaded back to us, you will get paid for 

them. Should a GTT error prevent this, we will immediately notify you to stop working until the 
problem has been solved. 
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Q: What if my projects expire? How do I know when a project will expire? Do I still get paid 
for the projects that I have translated? 

A: Do not work on them. Since we are not able to download expired projects, we cannot provide 
compensation for those projects. Please be sure to translate all projects before their expiration 
date and hide those that have expired. The expiry date is clearly marked next to each project ID. 

 
Q: How do I access the glossary in the GTT? 
A: The Booking.com glossary for your language should be available right away. To check this, 

please go to Edit-Properties within the GTT to see if the proper glossary is available for you. If 
you do not see the glossary, please send an email to freelancing@booking.com. 

 
Q:  What is a high fuzzy match and how should I use it? 
A: A high fuzzy match means that part(s) of the segment has already been translated. It is up to you 

whether you use it or not; it can make your work easier and faster. 
 
Q: Is it possible to use a spell checker in the GTT? 
A: Depending on the language and/or the browser you use, it is possible to download and install 

spell checkers. The GTT has its own inbuilt spell checker for some languages. Go to „Edit‟ and 
click on „Check spelling‟. 

 
Q: I noticed it is possible to change the text‟s color in the GTT. Why is that relevant? 
A: You can use this function to mark all exact and high fuzzy matches. This way you can have an 

overview of how much work is ahead of you. Of course it‟s up to you whether you use it or not. 
We recommend the colour scheme mentioned earlier in this document – it helps us when there 
are questions about your project. 

 
Q: My Toolkit contains 2 folders named Active/Hidden. What does it mean? 
A: You can use these two folders to store active projects (Active) and the ones you already marked 

as complete (Hidden). This way you don‟t get confused. We recommend you move completed 
projects into your hidden folder until the invoice for those projects has been paid. Never delete 
projects! 

 
Q: Can I merge/split one or more sentences? If I need to merge 2 or more segments, can I 

translate the whole paragraph in one box and leave the other(s) empty? 
A: This is not a good solution. We created the Split/Merge functions to avoid the Translation Memory 

to be filled with segments containing too much information compared to the English version. 
Please, for merging and/or splitting, always use the dedicated functions. 

 
Q: How come the system does not let me use the Merge function? 
A: Please note that GTT only lets you merge segments included in the same paragraph. 
 
Q: Can I review/edit my projects after the download? 
A: No, unfortunately you cannot recheck and edit your translations. Once you mark your translation 

complete it gets downloaded back to us. That‟s why it is extremely important that you double 
check your texts before marking them complete. 

 
Q: What do I do if I clicked Translation Complete by accident before I completed 

proofreading? 
A: If you‟re very, very quick and uncheck it immediately hopefully the project would not have been 

downloaded to our system yet. However, always email and notify us of your mistake. 
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Q: Is it possible to have English text in the translation field as machine translation makes the 
translation corrupt? 

A: Yes, this is possible. You can activate this in the Settings-Editing section by clicking “Pre-fill with 
source text instead of machine translation”. 

 
Q: What do I do if the source text isn‟t in English? 
A: Please leave the segment empty and send an email to your language team, copying in 

freelancing@booking.com, stating the hotel name, ID and section in which the error occurs. 

 
Q: How do I check the word counts for each translation match? 
A: The statistics for each project are visible in the View menu, under Statistics. You will see the 

amount of words for each type of match: 
 

o 100% TM matches are sentences saved in our Translation Memory - these will be paid 
30% of your rate 

o 'High fuzzy' TM matches are fuzzy matches - these will be paid 60% of your rate 
o Machine translation - these words will be paid at your full rate 
o ICE matches – these will be paid at 30% of your rate 
o Repeat matches – these will be paid at either 60% or 100% of your rate 

 
Sentences that appear as a 100% TM match *must* always be carefully proofread by you, as 
you are responsible for the quality of your translations. 

 
Q: I have finished my translations but it doesn‟t show 100% complete. Why not? 
A: Once you click Translation Complete the percentage will change to 100%. 
 
Q: I sometimes get error messages in the GTT like “this is taking longer than usual” or 

“saving” errors. What now? 
A: These error messages are Google server issues and there is nothing we can do about it. Please 

be patient and try again later. Please also make sure that your segments are saved before you 
mark a translation as complete. 
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